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Collaborative Writing with Google Docs
Summary
• Online writing tools, such as Google Docs or Office365, allow for real-time collaborative
work with teammates on research proposals.
• Suggesting mode, a feature similar to track changes, is a useful tool to allow for
discussion points without deleting important sections.
• Online writing tools automatically save changes every couple of minutes, which decreases
the possible risk of loss of work.
• Most online tools have the ability to show past edits and changes; revision history
improves accountability by being able to see who has contributed what and at what time.
• Some online tools do not have the same robust chart/table capabilities as their desktop
counterparts.
• There may be a lag if many collaborators are working on an online document at the same
time or if your internet latency is poor.
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Online writing tools, such as Google Docs or Office365, allow for real-time
collaborative work with teammates on research proposals.
Suggesting mode, a feature similar to track changes, is a useful tool to allow for
discussion points without deleting important sections.
Online writing tools automatically save changes every couple of minutes, which
decreases the possible risk of loss of work.
Most online tools have the ability to show past edits and changes; revision history
improves accountability by being able to see who has contributed what and at what time.
Some online tools do not have the same robust chart/table capabilities as their desktop
counterparts.
There may be a lag if many collaborators are working on an online document at the
same time or if your internet latency is poor.

Introduction
Collaborative writing is a crucial part of team projects in the modern-day workplace. A couple of
very user-friendly platforms for collaborative writing include Google Docs and Word Online
(Office365), though in this chapter we will particularly look into Google Docs. Google Docs is a
useful tool utilized by many to work on documents with peers and coworkers. This free platform
can substantially reduce the time needed to save and send out documents every time an edit has
been made as it displays all edits made in real-time with all revisions automatically saved. This
also minimizes the risk of losing key changes to documents and the need to keep track of different document versions. Google Docs also shows team member’s names as they add content
along with displaying the revision history; this helps improve accountability among team members. This platform also saves documents through Google Drive, which contains two drives that
organize important files for you: MyDrive and Shared With Me. MyDrive is your personal drive
and Shared With Me contains folders and documents that others have shared with you. In this
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chapter we present key benefits and limitations of Google Docs, along with a practical usage
guide.

Benefits
Automatic saving & revision history
Using Google Docs for collaborative writing is a powerful tool when used to its fullest potential.
The first step is obtaining a Gmail account. Once you have obtained a Gmail account, you will
have free access to Google Docs. Online tools, such as Google Docs, are far superior tools in
comparison to desktop applications because of their collaborative capabilities. One such capability is the automatic saving feature, which helps to avoid a possible loss of work and unneeded
troubles. Conversely, slow internet connections can make these on-line tools tedious to use.
Revision history summary, which works in tandem with the automatic saving feature, is very
useful because it helps you see collaborators’ inputs in the file with every revision history being
visible by clicking “See version history” under “Version history” in the “File” tab (viewable in
the How to View Revision History guide). This, therefore, increases accountability amongst collaborators by being able to see all tracked changes and which ones are actively adding content as
well as which ones are not. Revision history is also helpful because you are less likely to lose
track of document versions, which have been used in the traditional model of emailing back
Microsoft Word documents amongst collaborators. With this traditional method, if multiple reviewers send emails with advice, you may accidentally lose one and miss out on their edits.
Ultimately, it saves you time in reconciling the different edits made by your colleagues at
varying times and on different versions of the document.

Suggesting vs. editing
A notable advantage of Google Docs is the ability to toggle between editing and suggesting
mode, which can be found by selecting the pencil icon right underneath the share button
(viewable in the Suggesting vs. Editing Mode guide). Editing mode is appropriate to use while
making actual changes to the document, but for times when you may want to suggest a change to
bring up with fellow collaborators, suggesting mode is appropriate. This feature is a more engaging comments tool because it allows you to suggestively cross out sections, add content, and add
punctuation as opposed to just vaguely commenting. It is a similar feature to “Track Changes” in
Microsoft Word.

Organization
Organization is a major advantage to using Google Docs with many organizational functions
existing on the platform. A useful organizational tool in Google Docs is the ability to create
headings to clearly divide sections appropriately; this is similar to the headings feature in
Microsoft Word. By doing this you will be able to view the different headings of the document
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and navigate to the desired section by activating the “Document Outline” feature (referred to as
the “Navigation Pane” in Microsoft Word), which creates a panel on the left side of the screen.
This panel will list each of the headings and allow you to navigate quickly by clicking on the
heading on the left side.
Another organizational advantage of Google Docs is that it facilitates the ability to integrate
comments from different reviewers on the same document. Sometimes reviewers may have conflicting advice on the same document, and it is helpful to see the previous advice commented
within the area of interest. This is important so reviewers are able to take this previous advice
into account before formulating their own; this will speed up the editing process tremendously.

Creating citations
Google Docs has the ability to install free add-ons that are useful for scientific writing. For
instance, PaperPile is a reference management software that allows you to collect and manage
references while you write (of note, it has a monthly subscription fee after a trial period). Using
the Google add-on store, you can install the PaperPile add-on, which will automatically update
your references in the correct order. Collaborating colleagues can also install the PaperPile addon. There are many other helpful add-ons that you can explore in the Google add-on-store as
well.
Additionally, Google Docs is very helpful in creating citations by allowing you to embed links
within documents. One way this is utilized is when referencing specific sources found in the
works cited section of a document (viewable in the Embedding Links Within Documents guide).
You can create a link in the text of a document, and then by clicking on the in-text citation
Google Docs will redirect you to the desired source in the works cited. This is useful when
working on research projects because it is recommended to have at least 20 sources, which can
otherwise make documents rather unorganized and hectic to navigate through.

Limitations
Screen delay
Despite these helpful capabilities, there are several limitations that come with the platform which
should be considered. One such limitation is the possibility of the platform being slow if there
are many tracked changes. With many people collaborating on the same document simultaneously, this may result in lag and slow response time as they make edits, though this is not always
the case. This comes as a result of the real-time collaboration feature the platform provides and
the multiple versions that are saved as a result of every edit. To reduce this lag, in some cases it
can help to create a clean, new version by: 1) reviewing the document and accepting or rejecting
all comments; 2) then making a copy, but not selecting the “Copy comments and suggestions”
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box. This new copy will not have the past log of version edits and thus may load faster and be
more responsive as you navigate and edit it.

Formatting
Another issue many people encounter when dealing with data in Google Docs is related to
formatting charts or graphs. While pasting forms of data into the platform, the data inserts at
incorrect areas and moves text around inconveniently at times. This may result in you spending
valuable time reformatting your work, or even needing to export the document to Word to use its
custom formatting to create tables or graphs.

Security
Security is a point of concern regarding online platforms. It is possible for your team members to
not have secure connections, which can make important information accessible to hackers.
Hackers can view or edit your documents if they are able to access them through your team
members’ accounts if they do not have secure passwords, so it is important to be careful of who
has access to the document as well as the permissions granted. Getting hacked is a possibility
you may experience while using the Google suite, though Google has stepped up its response to
this risk. Google has increased its security by its implementation of two-factor authentication
and two-step verification; it is crucial for you to take a moment and enable those features on
your Google account, and encourage your collaborators to do the same. Also, whenever using
your Google account on another computer (such as a library computer), make sure to sign out
before you leave. In addition, it is important to not have any protected health information (PHI)
of patients on Google Docs to ensure patient confidentiality.
An additional measure to reduce the likelihood of losing your documents is to install the Google
Sync app so your Google Drive is regularly copied to your computer. You could then include
this folder in a regular backup protocol for your computer, such as backing up to an external
hard drive, for added security. In this way, if your Google Drive folder is hacked because of a
compromised password, you should still have a copy of your documents on your external hard
drive.

Best Practices
1. Utilizing headers. Use the “headers” feature to have standard formatting and allow use
of the Navigation Pane feature (viewable in the Creating Headings section).
2. Sharing feature. Periodically check to see who has access to the document by checking
“Share” -- make sure it is not public to the world and that only select users can edit or
delete it.
3. Archiving documents. If you make a document inactive, make sure to indicate that in
the Google filename and also in the document so someone does not believe it is active
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by accident. For example, you could title an inactive document as “ARCHIVE_Project
Proposal.”
4. Organizing your document. Your document may span across different folders -- you
may have one folder on your computer and another folder on Google Drive. Be sure you
leave clear notes to yourself so that if you come back to the document later you can
remember where items are kept. When the project is finished, it is often helpful to
download a final copy of the Google Doc as a Word document to your personal
computer in case you lose your Google account in the future.
5. Assisting colleagues with Google Docs. Before you start writing, make sure all the coauthors agree to use Google Docs -- it is a problem if one author refuses and then time is
wasted converting files from Google Docs to Microsoft Word every few days. It is good
practice to have a brief 30 minute meeting with a new Google Docs user to walk them
through the platform.

Recommended Folders
For your research project, you should create a clear folder structure so that documents are easy
to find. Common folders that are useful include:
● Resources: Contains PDFs of manuscripts from your literature review.
● Letters of Support: Any letters provided by consultants or clinics which mention
that they are willing to support your research project. Though not all research
projects require letters of support.
● CVs or Biosketches: CVs or Biosketches from collaborators, consultants, or coinvestigators.
● Oversight: Used to store documents related to your IRB submission or other
regulatory requirements.
● Instructions: PDFs or other documents provided by your teacher or others.

Creating a Document
Creating a document on Google docs is very user-friendly with the process only taking a few
clicks. The first step is to click on the new icon to begin creating a new document.
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Figure 1. The New Button.

After this step, users can proceed to create a new document of any kind by selecting the
appropriate dropdown. For this manual we will proceed by selecting “Google Docs.”
Figure 2. New Google Docs Document.

This screen will then appear. Proceed to name the document by clicking on the “Untitled
Document” section found in the top left corner of the document and typing the name.
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Figure 3. Naming the Document.

For the purpose of this manual we will name the document “Test.”

Sharing a Document
To share this document with peers proceed to click on the “Share” button found at the top right
of the document.
Figure 4. The Share Button

After selecting “Share”, enter the emails of those you wish to give access and be mindful of the
permissions you grant these people. When you finish adding collaborators click “Send.”
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Figure 5. Sharing with Collaborators

By clicking on “Get link” you can also have a copyable link which you can send for quick
sharing of the document.
Figure 6. Getting a Shareable Link
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How to Create a New Version
You may want to create a new version on a document in order for you to restore this version in
the future. To do this, first navigate to the “File” tab, go to “Version history,” and then select the
side tab “Name current version.”
Figure 7. Naming the Current Version

Proceed to name this version and save.
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Figure 8. Saving the Version Name.

How to View Revision History
An important collaborative tool is viewing the revision history to see which collaborators have
edited the document. To do this, first click on the “File” tab at the top, select the “Version
History,” then find the option “See version history.”
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Figure 9. Accessing the Version History.

After selecting “See version history” this sidebar will appear on the right side, which will display
who added content to the document with the exact date and time it was added. In this example,
we can see two instances of editing, and the version just created appears as well.
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Figure 10. The Version History.

This is important because you can go back and select this version if you want to restore it from
its current state. An important note, restoring a previous version will override all changes made
since you saved that version.

Suggesting vs. Editing Mode
Editors of documents are automatically in editing mode, though suggesting mode is useful to
point out areas that need revisions. To toggle between suggesting mode
and editing mode, first click the pencil icon just underneath the “Share” button.
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Figure 11. Suggesting Mode.

After selecting “Suggesting” mode, make any changes you would like to suggest to other editors
of the document. In this example we will delete some sentences. First, select the section and hit
backspace or delete.
Figure 12. Sample Section to Delete.

In suggesting mode, the deleted section will appear crossed out in green. On the right-hand side
a pop-up will appear with the change just made in suggesting mode.
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Figure 13. Sample Suggestion to Delete.

At this point if you navigate your cursor to the box, editors can either select the check-mark to
accept the change or select the “X” to reject the change. This feature is different from comments
because it highlights specific changes to make and allows for a quick approved edit without
discussion.
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Figure 14. Accept and Reject Suggestion.

Navigating Between MyDrive and Shared With Me
Google Drive is a useful tool for storing various file types that is also accessible from any device
with Gmail access. When selecting Google Drive, you can find any document you have created
under the MyDrive. For example, you can see the document created earlier named “Test” under
MyDrive. To view the document in MyDrive when in the document first click the Google Docs
logo in the top left corner.
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Figure 15. The “Docs home” Button.

Selecting this will bring you to Docs Home. Proceed to click the “main menu” button just to the
left of the Docs logo. Select the Google Drive icon on the left sidebar.
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Figure 16. Opening Google Drive.

This will bring you to MyDrive, and you can find the document under “Files.” You can find all
documents created within MyDrive in this area.
Figure 17. MyDrive.
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Shared With Me is another feature of Google Drive that is essential to collaboration. In order to
have files or folders in this subsection, someone will first have to share a file or folder to you.
Simply click on the “Shared With Me” tab and all documents shared with you will appear here.
You can move, open, share, download, remove, or edit the document depending on the permissions you have been granted.
Figure 18. Shared With Me.

Installing Add-ons
Select the “Add-ons” header (circled in red) and choose “Get add-ons.”
Figure 19. The Add-ons Header.

The Google Docs add-on store will appear where you can search for add-ons such as PaperPile.
Use the search bar circled in red to find specific add-ons.
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Figure 20. The Add-on Store.

Embedding Links within Documents
You may want to embed links within documents to better organize your document. This is done
in the context of scientific writing when you want to link your in-text citations to your works
cited. This makes navigation through the document much easier. Of note, if you plan to submit
an NIH grant, you are not allowed to have links to outside documents and in general should
avoid having any embedded links.
To create internal embedded links to facilitate document navigation, you will need an in-text
citation in place and a formatted source in a works cited listed as a header. First, highlight your
in-text citation.
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Figure 21. Sample In-text Citation.

Next, click the “Insert tab and then select “Links.”
Figure 22. Inserting a Link.

This window will now appear. Proceed to click “Headings.”
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Figure 23. The Headings Button.

Next, select the header in the works cited corresponding to the source you want to link.
Figure 24. Linking to a Source.

After selecting the header corresponding to the source in the works cited and selecting “Apply,”
the link will appear under the in-text citation.
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Figure 25. Sample Embedded Link.

Click on this link and you will easily navigate to your full citation.
Figure 26. Sample Full Citation.

Creating Headings
Headings within documents allow users to navigate to different sections with ease. This is
especially helpful in larger documents. To create a heading first highlight what text you want to
make into a heading.
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Figure 27. Sample Heading Text.

Next navigate to the “Normal text” dropdown.
Figure 28. The Text Styles Button.

Proceed to click the down-arrow. For this example we will select “Heading 1,” and then click
“Apply Heading 1.”
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Figure 29. Heading 1.

After clicking this you can see the selected text as a Heading 1 on the left side of the screen.
“Heading 2” and “Heading 3” are useful for creating subheadings, and they will appear more
indented in comparison to “Heading 1” in the left pane.
Figure 30. Sample Heading in Document Outline.
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You can easily navigate to the section you want by clicking on the corresponding heading in the
left pane.

Conclusion
Online writing tools are very helpful for real-time collaboration with peers in any setting.
Google Docs is a useful online aide because it is a free platform that is much more effective than
traditional desktop only platforms because of its collaborative features alone. Google Docs
shows the revision history which is a useful tool in improving accountability amongst
collaborators. Suggesting and Editing modes are very useful in working on large documents as
well. Aside from these aspects, there are a couple of limitations to consider that have to do with
slow response time due to lag, security concerns, and formatting difficulties with graphs and
charts. Despite these potential limitations, Google Docs can optimize your collaborative writing.

Resources
A Google Sheet checklist to assist with preparing your research proposal is available and
includes a section with specific checklist items related to this chapter:
https://docs.google.com/spreadsheets/d/1Z5AvaQwQPaWz6OTEPmK0_QF6PAvhHlCwwyjm1bdvzI/edit#gid=0 (a copy is also available at
the end of this book). We encourage you to copy this master Google Sheet checklist to your
Google Drive and edit it.
1. https://paperpile.com/blog/free-google-docs-add-on/
● This resource explains Paperpile and how to install the add-on.
2. https://docs.google.com/document/d/17KdPzANEFs2MZwgT-BEzAKei9saxKIT8/edit
● This resource outlines some useful benefits and limitations of Google Docs.
3. https://www.digitaltrends.com/computing/how-to-use-google-docs/
● This resource explains how to create a Google account and includes a manual of
regular aspects of the platform such as: suggesting vs. editing mode and creating
a new document.
4. https://www.howtogeek.com/420971/the-beginners-guide-to-google-docs/
● This resource gives more background detail on Google Docs.

________________________
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The contents of this chapter represent the opinions of the chapter authors and editors. The contents
should not be construed as legal advice. The contents do not necessarily represent the official
views of any affiliated organizations, partner organizations, or sponsors. For programs or
organizations mentioned in this chapter, the authors encourage the reader to directly contact the
relevant organization for additional information.
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